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Introduction

Thank you for selecting the FlashPro Programming System. This User’s Guide is designed to 
help you take full advantage of FlashPro’s capabilities.

Document Organization
This guide provides detailed information about FlashPro. Step-by-step instructions for using 
FlashPro on Windows are included in this guide. This guide is based on FlashPro version 3.2.

The FlashPro User’s Guide is divided into the following chapters:

• Chapter 1 - “Getting Started” explains how to install the hardware and software for FlashPro 
and FlashPro Lite. Details about the graphical user interface are included.

• Chapter 2 - “Using FlashPro” describes how to use the FlashPro software to program 
ProASIC and ProASIC PLUS devices.

• Chapter 3 - “Using FlashPro Lite” describes how to use FlashPro Lite to program 
ProASICPLUS devices.

• Chapter 4 - “Using FlashPro3” describes how to use the FlashPro3 software to program 
ProASIC3/E devices

• Appendix A - “Error Messages & Troubleshooting Tips” contains actions for error messages 
and warnings.

• Appendix B - “Software Freeze” describes the steps to take if the FlashPro software crashes.

• Appendix C - “Electrical Pin Outs” shows electrical pin out diagrams of FlashPro, FlashPro 
Lite, and FlashPro3.

• Appendix D - “Product Support” describes our support services.

Document Assumptions
The information in this manual is based on the following assumptions:

• You are familiar with the Actel Designer software.

• You are familiar with FPGA architecture and FPGA design software.
5



Platform Support
Platform Support
Supported platforms for the PC include:

• WinNT 4.0 SP6

• Win2000 SP4

• WinXP SP1

Actel Application Notes
Application Notes are available at our website, http://www.actel.com/products/tools/prog.asp.

Several Application Notes are specifically helpful to programming ProASIC and ProASICPLUS 
devices.

• Programming Actel Devices

• Implementation of Security in Actel ’s ProASIC and ProASICPLUS Flash Based FPGAs

• In-System Programming ProASICPLUS Devices

Actel User Manuals
Other Actel user manuals are available at our web site, under Technical Documentation
http://www.actel.com/techdocs/manuals/default.asp.
6 FlashPro v3.3 User’s Guide
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1
Getting Started

This chapter describes what is included in the FlashPro and FlashPro Lite kits and how to 
install the FlashPro software and hardware. It also contains an overview of the graphical user 
interface and commands.

For specific details about the board layout, please refer to the Actel application note, 
In-System Programming ProASICPLUS Devices.

FlashPro Kit
The FlashPro kit contains:

• FlashPro CD

• FlashPro Actel Programmer

• IEEE-1284 25 pin cable, Type A-C, 10 ft.

• Loop Back Test board

• Power supply brick and cable

• USB A to B Cable

FlashPro Lite Kit
The FlashPro Lite kit contains:

• FlashPro CD

• FlashPro Lite Programmer

• IEEE-1284 25 pin extension cable, Type A-A, 10 ft.

• 18 inch programmer target cable, 26 pin

FlashPro3 Kit
The FlashPro3 kit contains:

• FlashPro CD

• FlashPro3 programmer

• USB cable A to mini B 5 pin

• 10 pin target cable, 6 inch
7



Hardware Installation
Hardware Installation
For Hardware installation for FlashPro, FlashPro Lite and FlashPro3 refer to the following:

• For FlashPro, see “Hardware Installation” on page 19

• For FlashPro Lite, see “Hardware Installation” on page 41

• For FlashPro3, see “Hardware Installation” on page 57

Software Installation
Installing and use of the FlashPro software requires that you have administrative privileges on your 
local machine. After installing the FlashPro software, you must install the most recent service packs 
available from our website at:

http://www.actel.com/custsup/updates/flashpro/index.html.

To install the FlashPro software:

1. Insert the FlashPro CD into your drive. The installation wizard starts, as shown in Figure 1-1.

Figure 1-1. FlashPro Installation Wizard
8 FlashPro v3.3 User’s Guide
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Software Installation
2. Click Next to see the license agreement.

3. Click Yes, then Next to accept the license agreement, as shown in Figure 1-2.

Figure 1-2. License Agreement

4. Click Next to install FlashPro to the default destination folder, as shown in Figure 1-3. To 
install to a different folder, click Browse and select another folder.
FlashPro v3.3 User’s Guide 9



Software Installation
Figure 1-3. FlashPro Destination Location

5. Click Next to complete your installation. The FlashPro software installs. 

6. Answer the question, “Will you use FlashPro3 or USB FlashPro?” (see Figure 1-4).

Figure 1-4. Selecting FlashPro3 or USB FlashPro

7. Click Yes if you are using either FlashPro3 or FlashPro via a USB port. 
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Software Installation
8. If you clicked Yes, follow the steps in the Information box to ensure that FlashPro3 or 
USB FlashPro is installed properly, and click OK as shown in Figure 1-5. 

Figure 1-5. Information Box

9. If you clicked No in the Question box, follow the steps below to complete installation.

10. Click Finish to restart your computer as shown in Figure 1-5. You will restart your 
computer before starting FlashPro.

Figure 1-6. Installation Complete
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Software Update Powering Down the Programmer
11. After rebooting, log in with your administrative privileges to load the driver. If you are asked, 
check the Load at Startup checkbox

Software Update
For the latest software update available, visit the Actel website at

http:// www.actel.com/custsup/updates/flashpro/index.html or by selecting Software Update from 
the Help drop down menu in the FlashPro software(see Figure 1-6).

Figure 1-7. Software Update Help Drop Down Menu

Powering Down the Programmer
Before you power down the programmer, make sure of the following:

• The programming sequence is complete

• You are not executing other actions such as VERIFY, ERASE, etc.

Hardware Update
After you install or update the FlashPro software, a Version Mismatch dialog box may appear so you 
can download an update to your FlashPro hardware. 

To update your hardware: 

1. From the Hardware Update dialog box, click OK.

2. After reading the message in the Hardware Update dialog box, click OK.

The Updating Hardware status window displays while your hardware updates.
12 FlashPro v3.3 User’s Guide
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Powering Down the Programmer Self-Test
Self-Test
Before you program any devices, please run the self-diagnostic test. 

To run the self-diagnostic test: 

1. Connect the loopback test board to the FlashPro programmer. 

2. Con

3. nect the FlashPro via your PC’s parallel port or USB port.

4. Turn on the FlashPro programmer.

5. Start the FlashPro Diagnostic software. From the Start menu, point to Programs, 
FlashPro V3.3, and click Diagnostic.

6. Connect to the FlashPro programmer by entering

openport lpt<port number>

Note: If your FlashPro programmer is attached using USB instead of a parallel port, you 
must enter

openport usb

The port number represents the parallel port you used to connect to the FlashPro programmer. 
If the FlashPro is connected to port 1, you would enter:

openport lpt1

If this fails, check your licensing dongles and make sure the FlashPro’s power is turned on.

7. Enter 

test

The unit enters the self-test mode, which lasts less than one minute. Do not interrupt the unit 
until the self-test mode is completed. If the self-test fails, you may see the following error 
messages:

• Failed self-test. VDDP setting: Expected 2300...27000. Actual 750 (see page 57).

• Loopback failure TDI->TDO. Expected 1, Actual 0 (see page 57).

• Parallel port device does not support IEEE-1284 negotiation protocol (see page 57).

Please refer to “Error Messages & Troubleshooting Tips” for help with error messages. If you 
are not successful, please contact technical support at tech@actel.com for assistance.
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Starting FlashPro Menu Bar
8. Close port.

9. Exit

Starting FlashPro
To start FlashPro, from the Start menu select Programs, FlashPro V3.3, and click FlashPro V3.3. 

FlashPro Software Graphical User Interface
The FlashPro software, as shown in Figure 1-7, consists of a menu bar, toolbar, log window, and 
areas to specify your STAPL file, device, and action.

Figure 1-8. FlashPro Software Graphical User Interface

Menu Bar
Use the menu bar to set up your programmer connection, specify the device, and to save your log file. 
From the File menu, you can set up the programmer connection, specify the device, and save or clear 
the programming log file, which appears in the log window.
14 FlashPro v3.3 User’s Guide



Toolbar FlashPro Software Graphical User Interface
Toolbar
The toolbar buttons in the toolbar, as shown in Figure 1-8, allow you to open a programming 
file (*.stp) and execute the action you selected from the Action window. 

Figure 1-9. FlashPro Toolbar

Action
Use the Action list menu to specify the action you want performed on the device. Options are 
available when a STAPL file is loaded. Options appear in Table 1-1.

Table 1-1. Action Options

Options Actions

QUERY_SECURITY

Checks the security status of the device. If the device is pro-
grammed with the security key, then this command returns 
with Read inhibit:1 Write inhibit:1. If the security key is not 
present, the values are Read inhibit:0 Write inhibit 0.

ERASE Erases the device.

READ_IDCODE Reads the device ID code. Does not display IDCODE.

VERIFY

Verifies whether the device was programmed with the loaded 
STAPL file. If the wrong STAPL file is loaded, Exit 11 
appears in the log window. A successful operation results in 
Exit 0.

PROGRAM Programs the device.

DEVICE_INFO
Displays the serial number of the device, the Design Name 
that is programmed into the device, and the checksum that is 
programmed into the device.

ERASE_FROM
(FlashPro3 only)

Erases FlashROM only.
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FlashPro Software Graphical User Interface Action
PROGRAM_FROM
(FlashPro3 only)

Programs FlashROM only.

VERIFY_FROM
(FlashPro3 only)

Verifys FlashROM only.

PROGRAM_ARRAY
(FlashPro3 only)

Programs the FPGA Array only.

ERASE_ARRAY
(FlashPro3 only)

Erases the FPGA Array only.

VERIFY_ARRAY
(FlashPro3 only)

Verifys the FPGA Array only.

PROGRAM
(FlashPro3 only)

Programs FPGA Array, FlashROM and/or security settings 
of the device.

ERASE_ALL
(FlashPro3 only)

Erases FPGA Array, FlashROM and/or security settings of 
the device.

ACTION_VERIFY
(FlashPro3 only)

Verifys FPGA Array, FlashROM and/or security settings of 
the device.

READ_IDCODE
(FlashPro3 only)

Reads the device ID code.

ENC_DATA_AUTHENT
ICATION
(FlashPro3 only)

Autenticates the encrypted data against the security settings 
you previously programmed into the device. This is a preven-
tative measure that stops the program from corrupting data 
into the device.

PROGRAM_SECURITY Programs security settings into the device.

DEVICE_INFO
(FlashPro3 only)

Displays the Device IDCODE, security settings, design 
name, checksum and FlashROM content that is programmed 
into the device. 

Table 1-1. Action Options

Options Actions
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Device FlashPro Software Graphical User Interface
Device
Options in the Device list specify the device within a chain. The selected action in the Action 
list is applied to this device with the exception of ChainBuilder STAPL files. ChainBuilder 
STAPL files perform actions on all devices specified by the STAPL file, and if you select a 
device from the Action list, it has no effect.

The Device list only appears after selecting Analyze Chain from the File menu.

Log Window
The Log window displays results of the action and any error messages.
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2
Using FlashPro

This chapter describes how to use the FlashPro programmer to program Actel ProASIC and 
ProASICPLUS devices. All screen shots shown refer to ProASICPLUS devices only and the 
options may vary for ProASIC and ProASIC3 devices. 

This chapter also contains information on how to program a chain using a ChainBuilder 
generated STAPL file.

Hardware Installation
For FlashPro Lite hardware installation procedures, please refer to the “Hardware Installation” 
on page 41 section for FlashPro Lite. For FlashPro3 hardware installation procedures, please 
refer to the “Hardware Installation” on page 57 section for FlashPro3.

To connect the FlashPro to your PC:

1. Connect the programmer to a parallel printer port on your PC. Connect one end of the 
IEEE-1284 cable to the programmer’s connector. Plug the other end of the cable into your 
parallel printer port and tighten the screws. You should not have any licensing dongles 
connected between the parallel port and cable.

Your port settings should be EPP or bidirectional. Actel also supports the ECP mode with 
the FlashPro version 2.1 software and newer versions.

2. Verify that you are connected to the correct parallel port on your computer. Actel 
recommends that you dedicate a port to the programmer. Connecting to a serial port or a 
third party card may damage the programmer. This type of damage is not covered by the 
warranty.

3. Verify that the FlashPro power switch is in the 0 position.

4. Power up the programmer. Plug the DC adapter into a power socket. Plug the other end 
of the AC power supply to the DC-IN input at the back of the FlashPro.

5. Turn on the programmer. Turn the FlashPro power switch to the 1 position. The POWER 
LED on the front of the programmer lights up. If it does not, contact Actel technical 
support at (888) 99-ACTEL.

To connect a single FlashPro to your PC using a USB port:

1. Connect the programmer to a USB port on your PC. Connect one end of the USB cable 
to the programmer's USB connector. Plug the other end of the cable into your USB port. 

2. From the “To connect the FlashPro to your PC:” instructions above, follow steps three 
through five.
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Initial Setup
Note: USB programming is slightly slower than programming through the parallel port for a 
single device. By using a hub, multiple devices can be programmed at once, which saves 
time.

To connect multiple FlashPros using a USB hub:

1. Connect the programmer to a USB hub. Connect one end of the USB cable to the programmer's 
USB connector. Plug the other end of the cable into a free port on the USB hub.

2. Connect the USB hub to the PC. If the hub is not already connected, then follow the 
instructions for the hub setup and connect the cable from the hub to the PC.

3. From the “To connect the FlashPro to your PC:” on page 19 instructions in this section, follow 
steps three through five.

It is possible to connect more than one FlashPro programmer to a hub. If there is only a single 
programmer attached, follow the normal flow, choosing "USB" as the port when connecting to the 
programmer. If there is more than one programmer connected to the hub, a new instance of 
FlashPro software must be launched for every programmer (therefore, three connected FlashPros 
require launching three FlashPro software windows). Each instance must connect to a different 
programmer using the USB port. When connecting to a programmer, you must enter the serial 
number of the FlashPro into the serial number field.

Note: USB is hot-swappable, which means you do not have to power down the PC when 
plugging/unplugging the FlashPro programmer. Do not unplug the programmer while 
the programmer is active and performing a programming sequence.

Initial Setup
Before any action can be performed with the FlashPro programmer, it must be set up. Please connect 
the FlashPro ribbon cable with the programming header and turn on the switch. 

It is possible to connect more than one FlashPro programmer to a hub. If there is only a single 
programmer attached, follow the normal flow, choosing USB as the port when connecting to the 
programmer. If there is more than one programmer connected to the hub, a new instance of 
FlashPro software must be launched for every programmer (so three connected FlashPros require 
launching three FlashPro software windows). Each instance must connect to a different programmer 
using the USB port. When connecting to the programmer, you must enter the serial number of the 
FlashPro you are connecting to in the serial number field.

Note: USB programming is slightly slower than programming through the parallel port for a single 
device. By using a hub, multiple devices can be programmed at once, which saves time. 

Actel recommends running the self test before you program any devices; see “Self-Test” on page 13.
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Initial Setup
To set up FlashPro:

1. From the File menu, click Connect. The FlashPro Connect to Programmer dialog box 
displays, as shown in Figure 2-1. 

Figure 2-1. FlashPro: Connect to Programmer Dialog Box

2. In the Port list, select the port the FlashPro programmer is connected to.

3. In the Configuration list, select the device family (ProASIC , ProASIC PLUS, ProASIC3).

4. (Optional) Disable voltages from the programmer if they are available on the board. When 
you select the ProASIC configuration, the Drive TRST voltage turns grey and becomes 
unavailable, (see Figure 2-2).

Figure 2-2. Connect to Programmer Dialog Box for ProASIC Devices

Note: If you want to power-up the device from the board power supply, please deselect 
VDDL and VDDP. VPP and VPN are required during programming only and are 
supplied by the FlashPro programmer. Programming of ProASIC devices requires 
that VDDL be at 0 volts during programming. The board power supply design 
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Initial Setup
must allow for this if it is used to power-up the device during programming. 
ProASICPLUS devices do not have this requirement.

5. Click Connect. A successful connect or any errors appears in the Log window, as shown in Figure 
2-3. If you encounter failures, please refer to “Error Messages & Troubleshooting Tips” on 
page 89 for more information. 

Figure 2-3. FlashPro: Successful Connection
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Analyze Chain and Device Selection
Analyze Chain and Device Selection
To analyze the chain and select the device:

1. From the File menu, click Analyze Chain. Chain details appear in the Log window, as 
shown in Figure 2-4. The software should detect a minimum of eight instruction bits (the 
IR length of a ProASIC or ProASICPLUS device). If you encounter any failures, please refer 
to “Error Messages & Troubleshooting Tips” on page 89 for more information. 

Figure 2-4. FlashPro: Analyzing Chain

2. Select your devices. In the Device list, select your device before you perform any action. If 
you have only one device in the chain, performing Analyze Chain selects that device 
automatically from the Device list. If you have multiple devices in the chain, you must select 
a device as shown in Figure 2-5. 
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Loading the STAPL File
 

Figure 2-5. FlashPro: Device Selection

Note: The first device, selected in Figure 2-5, is the device that is nearest to TDO of the 
programming header.

Loading the STAPL File
The FlashPro programmer uses a STAPL (*.stp) file to program the device. Export the STAPL file 
from Designer. For more information, please refer to the Designer Online Help. 

Note: The STAPL file must be generated from Designer R1-2003SP1 or later. Actel strongly 
recommends that you use the latest version of Designer software or Libero IDE with the most 
recent service pack installed. Software service packs can be found at
http://www.actel.com/custsup/updates/index.html.

To load the STAPL file:

1. Click the Open File button in the toolbar, as shown in Figure 2-6. 

Figure 2-6. Open File Toolbar Button
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Selecting an Action
The Open dialog box appears, as shown in Figure 2-7.

Figure 2-7. Open Dialog Box

2. Select your STAPL file and click Open. The FlashPro software loads the file.

Selecting an Action
After loading the STAPL file, select an action from the Action list. See Table 2-1 for a 
definition of each action.

Table 2-1. Action Options

Option Action

QUERY_SECURITY

Checks the security status of the device. If the 
device is programmed with the security key, then 
this command returns with Read inhibit:1 Write 
inhibit:1. If the security key is not present, the 
values are Read inhibit:0 Write inhibit 0.

ERASE Erases the device.

READ_IDCODE
Reads the device ID code. Does not display 
IDCODE.
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Programming a Device
Follow the steps below to program a device.

To program a device:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

3. Click the Execute button in the toolbar, as shown in Figure 2-8. 

Figure 2-8. Execute Toolbar Button

VERIFY

Verifies whether the device was programmed with 
the loaded STPL file. If the wrong STPL file is 
loaded, Exit 11 appears in the log window. A suc-
cessful operation results in Exit 0.

PROGRAM Programs the device.

DEVICE_INFO

Displays the serial number of the device, the 
Design Name that is programmed into the device, 
and the checksum that is programmed into the 
device.

Table 2-1. Action Options

Option Action
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Programming a Device
The Execute Action dialog box appears, as shown in Figure 2-9.

Figure 2-9. Execute Action Dialog Box

All the steps of the programming sequence are listed. Optional steps appear in bold. Grayed 
out options are required for programming and cannot be changed.

4. Make your selections and click Execute to start programming. The progress of the 
programming action displays in the Log window. 

The message 'Exit 0' indicates that the device has been successfully programed, as shown in 
Figure 2-10.

Note: Do not interrupt the programming sequence. It may damage the device or 
programmer.
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Verifying the Correct Programming
Figure 2-10. Successfully Programmed Device

If you encounter any failures, please refer to “Error Messages & Troubleshooting Tips” on 
page 89 for more information.

Verifying the Correct Programming
Follow the steps below to verify that you programmed the device with the correct STAPL file.

To verify the device is programmed with the correct STAPL file:

1. Load the STAPL file.

2. In the Action list, click VERIFY.

3. Click the Execute button in the toolbar, as shown in Figure 2-11. 

Figure 2-11. Execute Toolbar Button
28 FlashPro v3.3 User’s Guide



Verifying the Correct Programming
The Execute Action dialog box appears, as shown in Figure 2-12.

Figure 2-12. Execute Action Dialog Box

The default settings appear in the Execute Action dialog box.

4. Click Execute to start the verification process. A successful verification will result in Exit 0, 
as shown in Figure 2-13. If the STPL file is different from the file used for programming, 
Exit 11 appears in the Log window (see “Error Messages & Troubleshooting Tips” on page 
89, “Exit 11” on page 92 for more details).
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Verifying the Correct Programming
Note: Do not interrupt the verifying sequence, it may damage the device.

Figure 2-13. Successful Verification
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Hardware Setup ChainBuilder Programming
ChainBuilder Programming
This section describes how to program a chain using a ChainBuilder generated STAPL file. 

Hardware Setup
Before you begin, it is important to set up your hardware. See “Initial Setup” on page 20 for 
more information.

Analyze Chain
Follow the instructions below to analyze the chain and select the device.

To analyze the chain and select the device:

1. From the File menu, click Analyze Chain. Chain details appear in the Log window, as 
shown in Figure 2-14. If you encounter any failures, please refer to “Error Messages & 
Troubleshooting Tips” on page 89 for more information.

Figure 2-14. FlashPro: Analyzing Chain

Note: When you program a chain using a ChainBuilder STAPL file, you cannot select a device 
to target.
FlashPro v3.3 User’s Guide 31



ChainBuilder Programming Loading the ChainBuilder STAPL File
Loading the ChainBuilder STAPL File
The steps below show you how to load the ChainBuilder STAPL file.

To load the ChainBuilder STAPL file:

1. Click the Open File button in the toolbar, as shown in Figure 2-15. 

Figure 2-15. Open File Button

The Open dialog box appears, as shown in Figure 2-16.

Figure 2-16. Open Dialog Box

2. Select your STAPL file and click Open. The FlashPro software loads the file.

After you analyze the chain and load the ChainBuilder STAPL file, you are ready to program the 
chain. 

Programming a Chain using a ChainBuilder STAPL File
To program a chain using a ChainBuilder generated STAPL file, select Program in the Action list, 
and click the Execute button.

The progress of the programming action displays in the Log window. The message 'Exit 0' indicates 
that the device has been successfully programmed.
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CheckChain Command ChainBuilder Programming
Note: The “CheckChain Command” runs before any other command to verify that your 
physical chain configuration matches your ChainBuilder STAPL file.

CheckChain Command
The CheckChain command is a pass/fail check for the chain you are programming and the 
ChainBuilder STAPL file. If the chain you are programming matches the chain expected by the 
ChainBuilder STAPL file, the check chain passes. 

Devices are listed in the device list box. However, if a device has an unknown ID or no ID, the 
chain is listed as "0:Chain" as shown in Figure 2-17. 

Figure 2-17. Device with Unknown ID

Note: In Figure 2-18, the part name of the device is listed because it is an unknown device with 
a known device ID.
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Permanently Lock the Device Loading the Permanent Lock STAPL File:
Figure 2-18. Unknown Device with Known ID

Permanently Lock the Device
The FlashPro software includes a new feature which enables you to permanently lock your device. 
The permanent lock feature permanently locks your device and prevents you from reprogramming. 
This provides the highest level of security to the ProASICPLUS device family. 

Loading the Permanent Lock STAPL File:
Export the permanent lock STAPL file from Designer. See the note from “Loading the STAPL 
File” on page 24 in this chapter.

To load the permanent lock STAPL file:

1. Click the Open File button in the toolbar. The Open dialog box appears.
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Programming a Device Using Permanent Lock Permanently Lock the Device
2. Select your permanent STAPL file and click Open. The Permanent Lock About dialog box 
displays, as shown in Figure 2-19. 

Figure 2-19. Permanent Lock About Dialog Box

3. Read the message and click OK to load the permanent STAPL file. The FlashPro software 
loads the file.

Programming a Device Using Permanent Lock
Follow the steps below to program a device using permanent lock.

To program a device using Permanent Lock:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

3. Click the Execute button in the toolbar.
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Permanently Lock the Device Programming a Device Using Permanent Lock
The Execute Action dialog box appears, as shown in Figure 2-20.

Figure 2-20. Execute Action Dialog Box

Note: The Do_Secure_Permanent checkbox is checked automatically. You have the option of 
unchecking this box. However, if you do, you will not permanently lock your device. 

All the steps in the programming sequence are listed. Optional steps appear in bold. Grayed out 
options are required for programming and cannot be changed. 

4. Make your selections and click Execute to start programming. The progress of the programming 
action is displayed in the Log window. The message 'Exit 0' indicates that the device has 
successfully been programmed as shown in Figure 2-21.
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Reprogram a Securely Locked Device Permanently Lock the Device
Figure 2-21. Query Results for the Permanently Locked Device

Note: Do not interrupt the programming sequence, it may damage the device or 
programmer.

If you encounter any failures, please refer to “Error Messages & Troubleshooting Tips” 
on page 89 for more information.

Reprogram a Securely Locked Device
After you program a part using the security feature, you cannot erase, verify, or reprogram it 
without your original security key in the STAPL file. If you use the permanent lock feature, you 
cannot (under any circumstances) reprogram or erase the device.
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Permanently Lock the Device Reprogram a Securely Locked Device
You can reprogram a securely locked device using the original STAPL file by following the usual 
programming procedures. The UNLOCK_UKEY box is checked by default, and the software 
automatically unlocks the device before programming (see Figure 2-23).

Figure 2-22. UNLOCK_UKEY Default

You can also reprogram a device using a different STAPL file.

To reprogram a device using a different STAPL file: 

1. Connect the programmer.

2. Analyze the chain.

3. Load the original STAPL file you used to program and secure the device.

4. Perform the Erase action. The Erase action unlocks the device and erases the device contents.

5. Load another STAPL file to program.

If your security key does not match the security key programmed on the device, the software will 
generate an “Exit 17” error message.
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Saving Your Log File
All FlashPro results are displayed in the Log window. You can save these results into a file.

To save your log file:

1. From the File menu, click Save Log. The Save dialog box appears, as shown in Figure 2-23.

Figure 2-23. Save Dialog Box

2. Select a directory, type in the file name, and click Save. The FlashPro software saves the 
file.

Batch Mode
The batch mode is useful for scripts (automation) or for independent software that tries to 
access the FlashPro hardware without going through the FlashPro software's user interface. 

You can run the batch mode command from the C:/Actel/FlashPro v3.3/FlashPro v3.3 
directory if you installed it in the default location. Otherwise, run the batch mode command 
from an equivalent location depending on your installation directory. 
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Batch Mode Syntax
The batch mode has the following syntax (for FlashProv3.3 installed in default location): 

"C:\Actel\FlashPro\FlashPro_v33\jre\bin\java.exe" -Xmx128m -classpath flashpro.jar 
com.actel.jtag.FS2 -port <port> [-fam <APA|A5K>] [-disable <vddp>] [-disable <vddl> -action 
<action> <file>

You must specify the <action>, <port> and <file> arguments in the command. See Table 2-2 for a list 
of definitions for these arguments. A sample command is shown below:

"C:\Actel\FlashPro\FlashPro_v33\jre\bin\java.exe" -Xmx128m -classpath flashpro.jar 
com.actel.jtag.FS2 -port lpt1 -action PROGRAM C:\designs\STAPL\apa300.stp

Note: The return value is a “0” (if there are no errors) or an error number.

Table 2-2. Argument Description

Arguments Description

-action <action> 

The STAPL action that is performed. The exact 
actions contained in a STAPL file may vary, but 
the "ERASE", "PROGRAM", "VERIFY", 
"QUERY_SECURITY",  "DEVICE_INFO", 
and  "READ_IDCODE" commands should be 
present (note that the command is case sensitive).

<file> 
Should be the full path name of the STAPL file 
that is being used.

-fam <fam> 

The family of the device connected to the pro-
grammer (APA and A500K use different volt-
ages- they cannot be mixed). APA is the default 
family if none is specified.

-port <port> 
The port that connects to the FlashPro program-
mer (usually lpt1 or USB). 

-disable <vddl>
Disable VDDL from the FlashPro. Use this 
option if you are providing VDDL through your 
own board.

-disable <vddp>
 Disable VDDP from the FlashPro. Use this 
option if you are providing VDDP through your 
own board.
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3
Using FlashPro Lite

This chapter describes how to set up and use the FlashPro Lite to program Actel 
ProASICPLUS devices. FlashPro Lite does not support ProASIC (A500K) or ProASIC3/E 
(A3P/E) devices. All screen shots refer to ProASICPLUS devices only.

Hardware Installation
To connect the FlashPro Lite to your PC:

1. Connect the programmer to a parallel printer port on your PC. Connect one end of the 
IEEE-1284 cable to the programmer’s connector. Plug the other end of the cable into your 
parallel printer port and tighten the screws. You should not have any licensing dongles 
connected between the parallel port and cable.

Your port settings must be EPP or bidirectional. Actel also supports the ECP mode 
with the FlashPro v2.1 software and newer.

2. Verify that you are connected to the correct parallel port on your computer. Actel 
recommends that you dedicate a port to the programmer. Connecting to a serial port or a 
third party card may damage the programmer. This type of damage is not covered by the 
warranty.

3. Connect the FlashPro ribbon cable with the programming header and turn the target 
board on.

Initial Setup
Before any action can be performed with the FlashPro Lite programmer, it must be properly 
setup. See “Powering Down the Programmer” on page 12.

The FlashPro Lite’s Live and Status LEDs must be on. This indicates that the FlashPro Lite is 
getting power from the target board and is ready to use.
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Initial Setup
To setup FlashPro Lite:

1. From the File menu, click Connect. The FlashPro Connect to Programmer dialog box displays, 
as shown in Figure 3-1. 

Figure 3-1. FlashPro: Connect to Programmer Dialog Box

2. In the Port list, select the Line Printer (lpt) port the FlashPro programmer is connected to.

3. In the Configuration list, select the ProASIC PLUS device. FlashPro Lite only supports 
ProASICPLUS devices. Use FlashPro to program ProASIC devices.

4. Click Connect. A successful connect or any errors appears in the Log window, as shown in Figure 
3-2. If you encounter failures, please refer to “Error Messages & Troubleshooting Tips” on 
page 89 for more information. 

Figure 3-2. FlashPro: Successful Connection
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Analyze Chain and Device Selection
Analyze Chain and Device Selection
Follow the steps below to analyze the chain and select the device.

To analyze the chain and select the device:

1. From the File menu, click Analyze Chain. Chain details appear in the Log window, as 
shown in Figure 3-3. If you encounter any failures, please refer to “Error Messages & 
Troubleshooting Tips” on page 89 for more information.

Figure 3-3. FlashPro: Analyzing Chain

2. Select your devices. In the Device list, select your device before you perform any action. If 
you have only one device in the chain, performing Analyze Chain selects that device 
automatically from the Device list. However, if you have multiple devices in the chain, click 
the down arrow next to the Device text box, and select your device from the Device list 
menu.

Note: The first device, shown in the Device text box is the device nearest to TDO of the 
programming header.

Loading the STAPL File
The FlashPro Lite programmer uses a STAPL (*.stp) file to program the device. Export the 
STAPL file from Designer. For more information, please refer to the Designer Online Help. 
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Loading the STAPL File
Note: The STAPL file must be generated from Designer R1-03SP1 or later. Actel strongly 
recommends using the latest version of Designer software or Libero IDE with the most recent 
service pack installed. Software service packs can be found at
http://www.actel.com/custsup/updates/index.html.

To load the STAPL file:

1. You can click the Open File button in the toolbar, or from the File menu, you can click Open.

The Open dialog box appears, as shown in Figure 3-4.

Figure 3-4. Open Dialog Box

2. Select your STAPL file and click Open. The FlashPro software loads the file. The FlashPro Log 
window displays a message indicating that the software has successfully loaded the software. See 
Figure 3-5.
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Selecting an Action
Figure 3-5. STAPL File Loaded Successfully

Selecting an Action
After loading the STAPL file, select an action from the Action list. See
Table 3-1 for a definition of each action.

Table 3-1. Action Options

Option Action

QUERY_SECURITY

Checks the security status of the device. If the 
device is programmed with the security key, then 
this command returns with Read inhibit:1 Write 
inhibit:1. If the security key is not present, the 
values are Read inhibit:0 Write inhibit 0.

ERASE Erases the device.

READ_IDCODE Reads the device ID code.
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Programming a Device
Programming a Device
Follow these steps to program a device.

To program a device:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

3. Click the Execute button in the toolbar. 

VERIFY

Verifies whether the device was programmed with 
the loaded STPL file. If the wrong STPL file is 
loaded, Exit 11 appears in the log window. A suc-
cessful operation results in Exit 0.

PROGRAM Programs the device.

DEVICE_INFO
Displays the serial number of the device, the Design 
Name that is programmed into the device, and the 
checksum that is programmed into the device.

Table 3-1. Action Options

Option Action
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Programming a Device
The Execute Action dialog box appears, as shown in Figure 3-6.

Figure 3-6. Execute Action Dialog Box

All the steps of the programming sequence are listed. Optional steps appear in bold. Grayed 
out options are required for programming and cannot be changed. 

4. Make your selections and click Execute to start programming. The progress of the 
programming action appears in the Log window. 

Note: Do not interrupt the programming sequence, it may damage the device or programmer.

The message 'Exit 0' indicates that the device has been successfully programed, as shown in 
Figure 3-7.
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Verifying the Correct Programming
Figure 3-7. Successfully Programmed Device

If you encounter any failures, please refer to “Error Messages & Troubleshooting Tips” on page 
89 for more information.

Verifying the Correct Programming
Follow the steps below to verify that the device is programmed with the correct STAPL file.

To verify the device is programmed with the correct STAPL file:

1. Load the STAPL file.

2. In the Action list, click VERIFY.

3. Click the Execute button in the toolbar, as shown in.
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Verifying the Correct Programming
The Execute Action dialog box appears, as shown in Figure 3-8.

Figure 3-8. Execute Action Dialog Box

The default settings appear in the Execute Action dialog box.

4. Click Execute to start the verification process. A successful verification will result in Exit 0, 
as shown in Figure 3-9. If the STPL file is different from the file used for programming, 
Exit 11 appears in the Log window (see “Error Messages & Troubleshooting Tips” on page 
89, “Exit 11” on page 92 for more details).
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Permanently Lock the Device Loading the Permanent Lock STAPL File:
Note: Do not interrupt the verifying sequence, it may damage the device.

Figure 3-9. Successful Verification

Permanently Lock the Device
ProASICPLUS devices have a new feature which enables you to permanently lock your device. The 
permanent lock feature permanently locks your device and prevents you from reprogramming. This 
provides the highest level of security to the ProASICPLUS device family. 

Loading the Permanent Lock STAPL File:
Export the permanent lock STAPL file from Designer. See the note from “Loading the STAPL 
File” on page 43 in this chapter.

To load the permanent lock STAPL file:

1. Click the Open File button in the toolbar. The Open dialog box appears.

2. Select your permanent STAPL file and click Open. The Permanent Lock About dialog box 
displays, as shown in Figure 3-10. 
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Programming a Device Using Permanent Lock Permanently Lock the Device
Figure 3-10. Permanent Lock About Dialog Box

3. Read the message and click OK to load the permanent STAPL file. The FlashPro software 
loads the file.

Programming a Device Using Permanent Lock
Follow these steps to program a device using permanent lock.

To program a device using Permanent Lock:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

3. Click the Execute button in the toolbar, as shown in

The Execute Action dialog box appears, as shown in Figure 3-11.
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Permanently Lock the Device Programming a Device Using Permanent Lock
Figure 3-11. Execute Action Dialog Box

Note: The Do_Secure_Permanent checkbox is checked automatically. You have the option of 
unchecking this box. However, if you do, you will not permanently lock your device. 

All the steps in the programming sequence are listed. Optional steps appear in bold. Grayed out 
options are required for programming and cannot be changed. 

4. Make your selections and click Execute to start programming. The progress of the programming 
action is displayed in the Log window. The message 'Exit 0' indicates that the device has 
successfully been programmed as shown in Figure 3-12.
52 FlashPro v3.3 User’s Guide



Reprogram a Key Locked Device Permanently Lock the Device
Figure 3-12. Query Results for the Permanently Locked Device

Note: Do not interrupt the programming sequence, it may damage the device or 
programmer.

If you encounter any failures, please refer to “Error Messages & Troubleshooting Tips” 
on page 89 for more information.

Reprogram a Key Locked Device
After you program a part using the key lock feature, you cannot erase, verify, or reprogram it 
without your original security key in the STAPL file. 

You can reprogram a key locked device using the original STAPL file by following the usual 
programming procedures. UNLOCK_UKEY box is checked by default, and the software 
automatically unlocks the device before programming. See Figure 3-13.
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Permanently Lock the Device Reprogramming a Device Using a Different STAPL File
Figure 3-13. UNLOCK KEY Default

Reprogramming a Device Using a Different STAPL File
You can also reprogram a device using a different STAPL file.

To reprogram a device using a different STAPL file: 

1. Connect the programmer.

2. Analyze the chain.

3. Load the original STAPL file you used to program and secure the device.

4. Perform the Erase action. The Erase action unlocks the device and erases the device contents.

5. Load another STAPL file to program.

If the user security key does not match the security key programmed on the device, the software 
generates an error message, Exit 17.

Reprogramming a Permanently Locked Device
If you use the permanent lock feature, you cannot, under any circumstances reprogram or erase the 
device.
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Batch Mode Syntax Saving Your Log File
Saving Your Log File
All FlashPro results are displayed in the Log window. You can save these results into a file.

To save your log file:

1. From the File menu, click Save Log. The Save dialog box appears, as shown in Figure 3-14.

Figure 3-14. Save Dialog Box

2. Select a directory, type in the file name, and click Save. The FlashPro software saves the 
file.

Batch Mode
The batch mode is useful for scripts (automation) or other software that tries to access the 
FlashPro hardware without going through the FlashPro software's user interface. 

You can run the batch mode command from the C:/Actel/FlashPro/FlashPro_v33 directory if 
you installed it in the default location. Otherwise, run the batch mode command from an 
equivalent location depending on your installation directory. 

Batch Mode Syntax

The batch mode has the following syntax (for FlashProv3.3 installed in default location): 
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Batch Mode Batch Mode Syntax
"C:\Actel\FlashPro v3.3\FlashPro v3.2\jre\bin\java.exe" -Xmx128m -classpath flashpro.jar 
com.actel.jtag.FS2 -port <port> [-fam <APA|A5K>] -action <action> <file>

You must specify the <action>, <port> and <file> arguments in the command. See Table 3-3 for a list 
of definitions for the arguments you give when running the commands.

A sample command is shown below: 

"C:\Actel\FlashPro\FlashPro_v33\jre\bin\java.exe" -Xmx128m -classpath flashpro.jar 
com.actel.jtag.FS2 -port lpt1 -action PROGRAM C:\designs\STAPL\apa300.stp

Note: The return value is a “0” (if there are no errors) or an error number.

Table 3-2. Argument Description

Arguments Description

-action <action> 

The STAPL action that is performed. The exact 
actions contained in a STAPL file may vary, but 
the "ERASE", "PROGRAM", "VERIFY", 
"QUERY_SECURITY",  "DEVICE_INFO", 
and  "READ_IDCODE" commands should be 
present (note that the command is case sensitive).

<file> 
Should be the full path name of the STAPL file 
that is being used.

- fam <fam> 

The family of the device connected to the pro-
grammer (APA and A500K use different volt-
ages- they cannot be mixed). APA is the default 
family if none is specified.

- port <port> 
The port that connects to the FlashPro program-
mer (usually lpt1 or USB). 

 -disable <vddl>
Disable VDDL from the FlashPro. Use this 
option if you are providing VDDL through your 
own board.

 -disable <vddp>
Disable VDDP from the FlashPro. Use this 
option if you are providing VDDP through your 
own board.
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4
Using FlashPro3

This chapter describes how to set up and use the FlashPro3 to program Actel ProASIC3/E 
devices. 

Hardware Installation
This section describes hardware installation for single and multiple FlashPro3 programmers.

To connect a single FlashPro3 to your PC using a USB port:

1. Connect the programmer to a USB port on your PC. Connect one end of the USB cable 
to the programmer's USB connector. Plug the other end of the cable into your USB port. 

You will observe the amber LEDs initially flashing and then the amber Power LED will 
remain illuminated indicating a connection to a powered USB port.

Note: USB 1.1 programming is slightly slower than programming through the parallel port for 
a single device, but by using high-speed USB 2.0 programming is faster than a parallel 
port. By using a hub, multiple devices can be programmed at once, which saves time (see 
next section).

To connect multiple FlashPros using a powered USB hub:

1. Make sure your hub is a powered USB hub. Only powered USB hubs can be used. 

2. Connect the USB hub to the PC. If the powered USB hub is not already connected, then 
follow the instructions for the hub setup and connect the cable from the hub to the PC.

3. Connect the programmers to a powered USB hub. Connect one end of the USB cable to 
the programmer’s USB connector. Plug the other end of the cable into a free port on the 
USB hub.

You will observe the amber LEDs initially flashing and then the amber Power LED will 
remain illuminated indicating a connection to a powered USB port.

4. Repeat Step 2 above for each programmers you wish to add.

It is possible to connect more than one FlashPro3 programmer to a powered USB hub. If there 
is only a single programmer attached, follow the normal flow, choosing "USB" as the port when 
connecting to the programmer. If there is more than one programmer connected to the hub, a 
new instance of FlashPro software must be launched for every programmer (therefore, three 
connected FlashPro3s require launching three FlashPro software windows). Each instance 
must connect to a different programmer using the USB port. When connecting to a 
programmer, you must enter the serial number of the FlashPro3 into the serial number field.

Note: USB is hot-swappable, which means you do not have to power down the PC when 
plugging/unplugging the FlashPro3 programmer. Do not unplug the programmer while 
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Initial Setup
the programmer is active and performing a programming sequence(when the amber USB 
Activity light is flashing).

Initial Setup
Before any action can be performed with the FlashPro3 programmer, it must be set up properly. 
Please connect the FlashPro3 to the computer using the USB port. Make sure the orange Power 
LED is lit. Connect the ribbon cable with the programming header.

Actel recommends running the self test before programming any devices, see “Self-Test” on page 13.

To setup FlashPro3:

1. From the File menu, click Connect. The FlashPro Connect to Programmer dialog box displays, 
as shown in Figure 4-1. 

Figure 4-1. FlashPro: Connect to Programmer Dialog Box

2. In the Port list, select the port the FlashPro3 programmer is connected to.

3. In the Configuration list, select the device family (ProASIC3/E).

4. (Optional) Disable Vpump from the programmer if the voltage is on the board. To disable 
Vpump, deselect the checkbox for Vpump. 
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Initial Setup
5. Click Connect. A successful connect or any errors appears in the Log window, as shown in 
Figure 4-2. If you encounter failures, please refer to “Error Messages & Troubleshooting 
Tips” on page 89 for more information. 

Figure 4-2. FlashPro: Successful Connection
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Analyze Chain and Device Selection
Analyze Chain and Device Selection
To analyze the chain and select the device:

1. From the File menu, click Analyze Chain. Chain details appear in the Log window, as shown in 
Figure 4-3. If you encounter any failures, please refer to “Error Messages & Troubleshooting 
Tips” for more information.

Figure 4-3. FlashPro: Analyzing Chain

2. Select your devices. In the Device list, select your device before you perform any action. If you 
have only one device in the chain, performing Analyze Chain selects that device automatically 
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Loading the STAPL File
from the Device list. If you have multiple devices in the chain, you must select a device as 
shown in Figure 4-4. 

Figure 4-4. FlashPro: Device Selection

Note: The first device, selected in Figure 4-4, is the device that is nearest to TDO of the 
programming header.

Loading the STAPL File
The FlashPro3 programmer uses a STAPL (*.stp) file to program the device. Export the 
STAPL file from Designer. For more information, please refer to the Designer Online Help. 

Note: The STAPL file must be generated from Designer R1-2003SP1 or later. Actel strongly 
recommends using the latest version of Designer software or Libero IDE with the most 
recent service pack installed. Software service packs can be found at
http://www.actel.com/custsup/updates/index.html.
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Loading the STAPL File
To load the STAPL file:

1. Click the Open File button in the toolbar, as shown in
Figure 4-5. 

Figure 4-5. Open File Toolbar Button

The Open dialog box appears, as shown in Figure 4-6.

Figure 4-6. Open Dialog Box

2. Select your STAPL file and click Open. The FlashPro software loads the file.
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Selecting an Action
Selecting an Action
After loading the STAPL file, select an action from the Action list. See Table 4-1 for a 
definition of each action.

Table 4-1. Action Options

Option Action

QUERY_SECURITY

Checks the security status of the device. If the 
device is programmed with the security key, then 
this command returns with Read inhibit:1 Write 
inhibit:1. If the security key is not present, the 
values are Read inhibit:0 Write inhibit 0.

ERASE Erases the device.

READ_IDCODE Reads the device ID code.

VERIFY

Verifies if the device is programmed with the 
loaded STPL file. If the wrong STPL file is 
loaded, Exit 11 appears in the log window. A 
successful operation results in Exit 0.

PROGRAM Programs the device.

DEVICE_INFO

Displays the serial number of the device, the 
Design Name that is programmed into the 
device, and the checksum that is programmed 
into the device.

ERASE_FlashROM Erases FlashROM only.

PROGRAM_FlashROM Programs FlashROM only.

VERIFY_FlashROM Verifys FlashROM only.

PROGRAM_ARRAY Programs the FPGA Array only.

ERASE_ARRAY Erases the FPGA Array only.

VERIFY_ARRAY Verifys the FPGA Array only.
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Programming a Device
Note: If FlashROM and FPGA Array are read/verify protected, the passkey must be provided in the 
STAPL file to enable read back and verification of the FPGA Array and FlashROM. If the 
device is permanently locked and the FPGA Array and FlashROM is read/verify protected, 
the content can not be verified or read back after you program the security setting.

Programming a Device
To program a device:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

PROGRAM
Programs FPGA Array, FlashROM and/or 
security settings of the device.

ERASE_ALL
Erases FPGA Array, FlashROM and/or security 
settings of the device.

ACTION_VERIFY
Verifys FPGA Array, FlashROM and/or secu-
rity settings of the device.

READ_IDCODE Reads the device ID code.

ENC_DATA_AUTHENTICATION

Autenticates the encrypted data against the 
security settings you previously programmed 
into the device. This is a preventative measure 
that stops the program from corrupting data 
into the device.

PROGRAM_SECURITY Programs security settings into the device.

DEVICE_INFO

Displays the Device IDCODE, security set-
tings, design name, checksum and FlashROM 
content that is programmed into the
device. 

Table 4-1. Action Options

Option Action
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Programming a Device
3. Click the Execute button in the toolbar, as shown in
Figure 4-7. 

Figure 4-7. Execute Toolbar Button

The Execute Action dialog box appears, as shown in Figure 4-8.

Figure 4-8. Execute Action Dialog Box

All the steps of the programming sequence are listed. Notice that all of the steps are grayed 
out because they are required for programming and cannot be changed.

4. Click Execute to start programming. The progress of the programming action displays in 
the Log window. 

The message 'Exit 0' indicates that the device has been successfully programmed, as shown in 
Figure 4-9.

Note: Do not interrupt the programming sequence. It may damage the device or 
programmer.
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Verifying the Correct Programming
Figure 4-9. Successfully Programmed Device

If you encounter any failures, please refer to “Error Messages & Troubleshooting Tips” for 
more information.

Verifying the Correct Programming
To verify the device is programmed with the correct STAPL file:

1. Load the STAPL file.

2. In the Action list, click VERIFY.

3. Click the Execute button in the toolbar, as shown in 
Figure 4-10. 

Figure 4-10. Execute Toolbar Button
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Verifying the Correct Programming
The Execute Action dialog box appears, as shown in Figure 4-11.

Figure 4-11. Execute Action Dialog Box

The default settings appear in the Execute Action dialog box.

4. Click Execute to start the verification process. A successful verification will result in Exit 0, 
as shown in Figure 4-12. If the STAPL file is different from the file used for programming, 
Exit 11 appears in the Log window (see “Error Messages & Troubleshooting Tips”, “Exit 
11” for more details).
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ChainBuilder Programming Hardware Setup
Note: Do not interrupt the verifying sequence, it may damage the device.

Figure 4-12. Successful Verification

ChainBuilder Programming
This section describes how to program a chain using a ChainBuilder generated STAPL file. 

Hardware Setup
Before you begin, it is important to setup your hardware. See “Initial Setup” for more information.
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Analyze Chain ChainBuilder Programming
Analyze Chain
To analyze the chain and select the device:

1. From the File menu, click Analyze Chain. Chain details appear in the Log window, as 
shown in Figure 4-13. If you encounter any failures, please refer to “Error Messages & 
Troubleshooting Tips” for more information.

Figure 4-13. FlashPro: Analyzing Chain

Note: When you program a chain using a ChainBuilder STAPL file, you cannot select a device 
to target.

Loading the ChainBuilder STAPL File
To load the ChainBuilder STAPL file:

1. Click the Open File button in the toolbar, as shown in Figure 4-14. 

Figure 4-14. Open File Button
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ChainBuilder Programming Programming a Chain using a ChainBuilder STAPL File
The Open dialog box appears, as shown in Figure 4-15.

Figure 4-15. Open Dialog Box

Select your STAPL file and click Open. The FlashPro software loads the file.

After you analyze the chain and load the ChainBuilder STAPL file, you are ready to program the 
chain. 

Programming a Chain using a ChainBuilder STAPL File
To program a chain using a ChainBuilder generated STAPL file:

1. In the Action list, select PROGRAM.

2. Click the Execute button.The progress of the programming action displays in the Log window. 
The message 'Exit 0' indicates that the device has been successfully programmed.

Note: The “CheckChain Command” runs before any other command to verify that your 
physical chain configuration matches your ChainBuilder STAPL file.

CheckChain Command
The CheckChain command is a pass/fail check for the chain you are programming and the 
ChainBuilder STAPL file. If the chain you are programming matches the chain expected by the 
ChainBuilder STAPL file, the check chain passes. 

Devices are listed in the device list box. However, if a device has an unknown ID or no ID, the chain 
is listed as "0:Chain" as shown in Figure 4-16. 
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CheckChain Command ChainBuilder Programming
Figure 4-16. Device with Unknown ID

Note: In Figure Figure 4-17, the part name of the device is listed because it is an unknown 
device with a known device ID.
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Permanently Lock the Security Setting Loading the Permanent Lock STAPL File:
Figure 4-17. Unknown Device with Known ID

Permanently Lock the Security Setting
The FlashPro software includes a new ProASIC3/E feature which enables you to permanently lock 
the security setting of your device. The permanent lock feature permanently locks the security 
setting of your device and prevents you from modifying the security setting of the device. 

Loading the Permanent Lock STAPL File:
Export the permanent lock STAPL file from Designer. See the note from “Loading the STAPL 
File” in this chapter.

To load the permanent lock STAPL file:

1. Click the Open File button in the toolbar. The Open dialog box appears.

2. Select your permanent STAPL file and click Open. The Permanent Lock About dialog box 
displays, as shown in Figure 4-18. 
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Programming a Device Using Permanent Lock Permanently Lock the Security Setting
Figure 4-18. Permanent Lock About Dialog Box

3. Read the message and click OK to load the permanent STAPL file. The FlashPro software 
loads the file.

Programming a Device Using Permanent Lock
To program a device using Permanent Lock:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

3. Click the Execute button in the toolbar, as shown in 
Figure 4-19.

Figure 4-19. Execute Toolbar Button

The Execute Action dialog box appears, as shown in Figure 4-20.
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Permanently Lock the Security Setting Programming a Device Using Permanent Lock
Figure 4-20. Execute Action Dialog Box

Note: The Do_Secure_Permanent checkbox is checked automatically. You have the option of 
unchecking this box. However, if you do, you will not permanently lock your device. 

All the steps in the programming sequence are listed. Optional steps appear in bold. Grayed out 
options are required for programming and cannot be changed. 

4. Make your selections and click Execute to start programming. The progress of the programming 
action is displayed in the Log window. The message 'Exit 0' indicates that the device has 
successfully been programmed as shown in Figure 4-21.
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Reprogram a Securely Locked Device Permanently Lock the Security Setting
Figure 4-21. Query Results for the Permanently Locked Device

Note: Do not interrupt the programming sequence, it may damage the device or 
programmer.

If you encounter any failures, please refer to “Error Messages & Troubleshooting Tips” 
for more information.

Reprogram a Securely Locked Device
After you program a part using the security feature, you cannot erase, verify, or reprogram it 
without your original security key in the STAPL file. If you use the permanent lock feature, you 
cannot (under any circumstances) reprogram or erase the device.

You can reprogram a securely locked device using the original STAPL file by following the 
usual programming procedures.

You can also reprogram a device using a different STAPL file.
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Saving Your Log File Reprogram a Securely Locked Device
To reprogram a device using a different STAPL file: 

1. Connect the programmer.

2. Analyze the chain.

3. Load the original STAPL file you used to program and secure the device.

4. Perform the Erase action. The Erase action unlocks the device and erases the device contents.

5. Load another STAPL file to program.

If your security key does not match the security key programmed on the device, the software will 
generate an “Exit 17” error message.

Saving Your Log File
All FlashPro results are displayed in the Log window. You can save these results into a file.

To save your log file:

1. From the File menu, click Save Log. The Save dialog box appears, as shown in Figure 4-22.

Figure 4-22. Save Dialog Box

2. Select a directory, type in the file name, and click Save. The FlashPro software saves the file.
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Batch Mode Syntax Batch Mode
Batch Mode
The batch mode is useful for scripts (automation) or for independent software that tries to 
access the FlashPro hardware without going through the FlashPro software's user interface. 

You can run the batch mode command from the C:/Actel/FlashPro v3.3/FlashPro v3.3 
directory if you installed it in the default location. Otherwise, run the batch mode command 
from an equivalent location depending on your installation directory. 

Batch Mode Syntax
The batch mode has the following syntax (for FlashProv3.3 installed in default location): 

"C:\Actel\FlashPro\FlashPro_v33\jre\bin\java.exe" -Xmx128m -classpath flashpro.jar 
com.actel.jtag.FS2 -port usb[-fam <A3P>] [-disable <vpump>] <action> <file>

You must specify the <action>, <port>, <fam>, and <file> arguments in the command. See 
Table 4-2 for a list of definitions for these arguments. A sample command is shown below:

"C:\Actel\FlashPro\FlashPro_v33\jre\bin\java.exe" -Xmx128m -classpath flashpro.jar 
com.actel.jtag.FS2 -port usb -fam A3P -action PROGRAM C:\designs\STAPL\a3p600.stp

Note: The return value is a “0” (if there are no errors) or an error number.

Table 4-2. Argument Description

Arguments Description

-action <action> 

The STAPL action that is performed. The exact 
actions contained in a STAPL file may vary, but 
the "ERASE", "PROGRAM", "VERIFY", 
"QUERY_SECURITY",  "DEVICE_INFO", 
and  "READ_IDCODE" commands should be 
present (note that the command is case sensitive).

<file> 
Should be the full path name of the STAPL file 
that is being used.

-fam <fam> 

The family of the device connected to the pro-
grammer (APA and A500K use different volt-
ages- they cannot be mixed). APA is the default 
family if none is specified.
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Serial Programming Multiple Actions To Multiple FlashROM
Serial Programming
Serial Programming enables you to program a sequence of ProASIC3/E devices in serial with an 
identical FPGA Array and with different serial data. Serial data could be a serial of different 
FlashROM content and/or AES key values. There are two different STAPL formats that support 
serial programming:

• Multiple actions to multiple serial data- This format supports a generic STAPL player because the 
STAPL player does not provide a mechanism for serial programming. One programming action 
is created to target different serial data.

For example:

- PROGRAM_ALL_1 programs the FPGA Array and the first serial data.

- PROGRAM_ALL_2 programs the FPGA Array and the send serial data.

• Single action to multiple FROM- This format is created when the target programmer is 
FlashPro3, Sculptor II, or BP auto programmer, where new Actel innovated serial programming 
mechanism is supported. One programming action will program multiple serial data in serial.

Multiple Actions To Multiple FlashROM
By executing the action sequence in the STAPL file (created with different Core-FlashROM pairs), 
you can serial program multiple actions to multiple FlashROM.

Before you begin serial programming, make sure you have completed “Initial Setup” and “Analyze 
Chain and Device Selection”.

To start serial programming: 

1. Load a serialized STAPL file into the software. (See “Loading the STAPL File” for more 
information).

-port <port> 
FlashPro3 programmer can only connect using 
USB.

-disable <vpump>
Disable VPUMP from the FlashPro3. Use this 
option if you are providing VPUMP through your 
own board.

Table 4-2. Argument Description

Arguments Description
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Multiple Actions To Multiple FlashROM Serial Programming
A serialized STAPL file has Multiple FlashROM data. Depending on the model you use 
when generating the STAPL file, each FlashROM data could include a matching AES key.

Note: The Action Combo box contains all of the actions in the STAPL file. See
Figure 4-23.

Figure 4-23. Action Combo Box

2. Select Serial Programming from the Options menu.

The Serial Programming window appears as shown in Figure 4-24.
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Serial Programming Multiple Actions To Multiple FlashROM
Figure 4-24. Serial Programming Action Window 

3. Select the actions you want to execute by using the arrows to move from the Actions box to the 
Selected Actions box.

4. Click OK.

The Action Combo box will be grayed out and Serial Mode displays next to the Action 
Combo box as shown in Figure 4-25.
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Multiple Actions To Multiple FlashROM Serial Programming
Figure 4-25. Updated Action Combo Box

5. Click the Execute button in the toolbar.

The Execute Action dialog box appears as shown in Figure 4-26.
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Serial Programming Multiple Actions To Multiple FlashROM
Figure 4-26. Execute Action Dialog Box

6. Click Execute.

The Log window displays a passed or failed result. 

7. If it passed, the software automatically goes to the next action. Repeat steps 6 and 7. 

8. If it failed, it may skip or repeat the action until it passes depending upon which option you 
selected. See “Serialization Options” for more information.

Continue this process until you have finished executing all actions.

Note: The Log window displays a “completed serial programming message” when you have 
completed serial programming.

9. When finished, turn Serial Programming off by selecting Serial Programming from the Options 
menu.

An execution summary displays in the Log window.

Serialization Options

If your device fails to program, and you have selected the Reuse Serial Data option, the software 
automatically reuses the current serial data when you program the next device. If your device fails to 
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Single Actions to Multiple FlashROM Serial Programming
program, and you have selected the Skip Serial Data option, the software automatically uses 
the next serial data when you program the next device. 

To set serialization options:

1. From the Options menu, select Serialization Option.

2. Select either Reuse Serial Data or Skip Serial Data. See Figure 4-27.

Figure 4-27. Serialization Option

Your options are set.

Single Actions to Multiple FlashROM
Before you begin serial programming, make sure you have completed the “Initial Setup” and 
“Analyze Chain and Device Selection”.

Follow the steps below to program single actions to multiple FlashROM.

To start serial programming:

1. Load the STAPL file into the software. (See “Loading the STAPL File” for more 
information).
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Note: The Action Combo box contains all of the actions in the STAPL file. See Figure 4-28.

Figure 4-28. Updated Action Combo Box

2. Select Serial Programming from the Options menu.

The Serial Programming Index window appears as shown in Figure 4-29.

Figure 4-29. Serial Programming Index Window
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Single Actions to Multiple FlashROM Serial Programming
3. Select the actions you want to execute by using the arrows to move from the Serial Indices 
box to the Selected Serial Indices box.

4. Click OK.

The Serial Index box updates with the actions you selected from the Serial Programming 
Index window as shown in Figure 4-30.

 

Figure 4-30. Serial Index Box

5. Select the PROGRAM action from the the Action Combo box.

6. Click the Execute button.

The Execute Action dialog box appears as shown in Figure 4-31.
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Figure 4-31. Execute Action Dialog Box

7. Click Execute.

The Log window displays a passed or failed result. 

8. If it passed, the software automatically goes to the next action. Repeat steps 6 and 7. 

9. If it failed, it may skip or repeat the action until it passes depending upon which option you 
selected. See “Serialization Options” for more information.

Continue this process until you have finished executing all actions.

Note: The Log window displays a “completed serial programming message” when you have 
completed serial programming.

10. When finished, turn Serial Programming off by selecting Serial Programming from the 
Options menu.

An execution summary displays in the Log window.

Serialization Options

If your device fails to program, and you have selected the reuse serial data option, the software 
automatically reuses the current serial data when you program the next device. If your device fails to 
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Single Actions to Multiple FlashROM Serial Programming
program, and you have selected the skip serial data option, the software automatically uses the 
next serial data when you program the next device. 

To set serialization options:

1. From the Options menu, select Serialization Option

2. Select either Reuse Serial Data or Skip Serial Data. See Figure 4-32.

Figure 4-32. Serialization Option

Your options are set.
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A
Error Messages & Troubleshooting Tips

The information in this chapter may help you solve or identify a problem with the FlashPro 
programmer. If you have a problem that you can not solve, please contact Actel Customer 
Technical Support at tech@actel.com or call our hotline 1-800-262-1060. We are dedicated to 
making FlashPro as trouble-free as possible. This chapter contains information on error 
messages for ProASIC, ProASICPLUS, and ProASIC3/E devices. For a list of error messages 
for ProASIC3/E devices, refer to Table A-1.

Exit Codes
The following exit codes are for ProASIC and ProASICPLUS devices:

• “Exit 0” on page 90 

• “Exit 1” on page 90

• “Exit 2” on page 90

• “Exit 3” on page 90
• “Exit 5” on page 91

• “Exit 6” on page 91
• “Exit 7” on page 91
• “Exit 8” on page 92
• “Exit 11” on page 92
• “Exit 12” on page 93
• “Exit 15” on page 93

• “Exit 17” on page 93

• “Exit 80” on page 93 

• “Exit 90” on page 94
• “Exit 91” on page 94
• “Exit Null” on page 94

• “Cable to target is not connected properly” on page 95
• “Chain Integrity Test Failed: XX” on page 95
• “Could not connect to programmer on port lpt1 or Parallel port device does not 

support IEEE-1284 negotiation protocol” on page 96
• “External Voltage Detected on <Supply>” on page 96
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Exit 0
• “Failed self-test. VDDP setting: Expected 2300...27000. Actual 750” on page 97
• “Loopback Failure TDI -> TDO. Expected 1, Actual 0” on page 97
• “More than one unidentified device cannot continue” on page 97
• “Self-test” on page 98
• “VDDP Disconnected” on page 98

Exit 0
This message means success. This does not indicate an error.

Exit 1
Exit 1 is defined as a Checking chain Error. This means that the physical chain does not match the 
expected setup from the STAPL file.

Possible Causes:

• The physical chain configuration has been altered.

• Something has become disconnected in the chain.

• The specific IR length of non-Actel devices may be incorrect.

• The order of the specified chain may be incorrect. For example, the chain order may be in the 
reverse order.

Exit 2
Reading device ID failure.

Possible Cause: The device either does not have a valid device ID or the data cannot be read 
correctly.

Possible Solution: Check the device ID.

Exit 3
This occurs when using ProASICPLUS devices.

Possible Cause: Connect was set up for a ProASIC device and the device is actually a ProASICPLUS.

Solution: Set up for a ProASICPLUS device.
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Exit 5
Exit 5
Indicates a problem in programming setup, also known as “Entering ISP Failure.” 

Possible Cause: The A500K device senses the VDDL power supply as being on.

Solutions: 

• Power the VDDL down during programming.

• Check that the device has the correct voltages on VDDP, VDDL, VPP, and VPN.

Exit 6
JEDEC standard message. The IDCODE of the target device does not match the expected 
value in the STAPL file.

Possible Causes: 

• User loaded an APA150 STAPL file to program an APA300.

• User selected wrong device.

• Device TRST pin is grounded.

• Noise or reflections on one or more of the JTAG pins caused by the IR Bits reading it back 
incorrectly.

Solutions:

• Choose the correct STAPL file and select the correct device.

• Measure JTAG pins and noise or reflection. TRST should be floating or tied high.

• Cut down the extra length of ground connection.

Exit 7
Unknown algorithm: alg=x, prev=x
Invalid data read from device

Possible Causes: 

• In the factory row, the factory writes the algorithm revision the part is calibrated with. This 
error occurs with current STAPL files when the revision written into the factory row is not 
rev 2 for ProASIC devices or rev 1 for ProASICPLUS devices. The STAPL files from last 
year may "exit 7" with newer devices or the older revision may cause this failure if the STAPL 
file used is from latest version. This can occur if you are using Engineering Sample parts that 
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Exit 8
are no longer supported, such as ProASIC Engineering Sample parts. This error can also occur if 
the programmer has trouble reading the factory row due to signal noise, crosstalk, or reflections 
on the JTAG signal and clock lines.

• Programming -F ProASICPLUS device with old STAPL file.

• Connect VPP and VPN the wrong way around.

• No bypass Caps on VPP VPN, which damaged the device.

Solutions: 

• Re-generate STAPL file from Libero v2.3 SP3 or Designer R1-2003SP3.

• Replace A500K ES parts with commercial parts.

• Double check VPP and VPN connections.

• Make sure VPP and VPN have correct bypass caps.

• Check the signal quality on the JTAG signal and clock lines

Exit 8
This message occurs when the FPGA failed during the Erase operation.

Possible Causes: The device is secured, and the corresponding STAPL file is not loaded. The device 
has been permanently secured and cannot be unlocked.

Solution: Load the correct STAPL file.

Exit 11
The message occurs when the FPGA failed verify.

Possible Causes

• The device is secured, and the corresponding STAPL file is not loaded.

• You used the Libero software v. 2.3 or earlier or the Designer R1-2003 software or earlier to 
generate the STAPL file.

• VPN caps were soldered in the wrong polarity.

Solutions: 

• Please load the correct STAPL file.

• Please use later software versions-- at least Libero v2.3 SP1 and Designer R1-2003 SP1.

• Double check the VPN bypass caps polarity.
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Exit 12
Exit 12
Occurs when security is enabled.

Possible Causes:

• The device is secured and the wrong key/STAPL file was entered.

• The device is damaged.

• The verification was interrupted and therefore fails, causing it to think the device is secure.

Exit 15
This message is a factory Calibration Data CRC Error. During program, erase, or verify, the 
programmer must read back Calibration Data from the FPGA. The Data contains a CRC and 
the programmer uses the CRC to ensure the data is not corrupted/wrong.

Possible Causes:

• The device is damaged.

• Noise on the JTAG signals causes the programmer to read back wrong data.

Exit 17
This message means that the device has been secured, write-security enabled.

Possible Causes: 

• The device is secured and the wrong key/STAPL file was entered.

• The device is damaged.

Solution: Please load the correct STAPL file.

Exit 80
Error code results from STAPL files for A500K devices.

Possible Cause: 

• An internal calibration (based on VDDP and VPP) failed.

Solutions:

• Check voltages on the device pins.
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Exit 90
• Check voltages on the VDDP and VPP pins.

Exit 90
This message means that an unexpected RCK is detected. The ProASIC devices use either TCK or 
RCK to shape the programming pulse. The FlashPro uses TCK, it does not sense RCK directly. 
Rather, the device senses RCK and FlashPro reads it from the device.

Possible Causes: 

• Noise on the RCK signal.

• You connected a CLK source to the RCK signal.

• The polarized bypass capacitors on VPP or VPN are reversed biased and are affecting the 
programmer’s VPP or VPN output voltage. This is causing programming to fail.

• Several FlashPros are programming at the same time and are too close to each other.

Solutions:

• Disconnect the RCK and make sure TCK has a clean signal.

• Separate FlashPros away from each other while they are programming Internal ISP.

Exit 91
This message occurred because of a calibration data parity error. Before the FPGA is programmed, 
calibration data (stored in the device) are read back for programming purposes. The programmer 
performs a parity check on the data to ensure the proper data is read back.

Possible Cause: The device is damaged.

Solution: Please replace the device.

Exit Null
Possible Causes: 

• Several FlashPros are programming at the same time and are too close to each other.

• FlashPro connects to PC parallel port through a dongle key.

• Data length mismatch when performing DRSCAN on STAPL file.

Possible Solutions:

• Separate FlashPros away from each other while they are programming.
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Cable to target is not connected properly
• Connect FlashPro to PC parallel port directly.

• Regenerate STAPL file in case you mistakenly modified the file.

Cable to target is not connected properly
When the Analyze command is executed, the FlashPro will look for target devices. If the cable 
connection is wrong, FlashPro senses assumes that nothing is connected at all.

Possible Cause: The cable connector is not connected to the header properly or the connection 
from header to the device is missing something. Header pin 10 is the GND sensing pin. It 
senses if FlashPro is connected to the target’s GND. Also, all other GND pins should be 
connected to the GND plane.

Solution: Please confirm the connection between header to the device. If the board supplies the 
power to the device, please make sure the voltage level is correct.

Chain Integrity Test Failed: XX
When the analyze chain operation is performed, the FlashPro programmer expects the first two 
bits of the data from the device chain to be a “01.” When the programmer does not see the 01 
pattern, it will return an error and report the bit values that it read. For example, if the bits it 
read were 11, then it would return "Chain Integrity Test Failed: 3"

Possible Causes: 

• The connection between the FlashPro programmer and the Device is broken. 

• The programmer cable might not be securely inserted into the header.

• The header is not connected to the JTAG pins of the FPGA correctly.

• The configuration setting (ProASIC/ProASICPLUS) does not match the target device.

• Noise or reflections on the JTAG pins has caused communication between the programmer 
and the device to fail.

• A dongle is plugged in between the PC parallel port and the FlashPro parallel port cable.

Solutions:

• Please secure the connections.

• Check the JTAG pins for signal activity.

• Check for broken TDO, TMS, and TCK pins. 

• After checking all type of connections if the failure exists, you may need to replace the first 
device (the devices closest to the TDO of the programming header) in the chain.
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Could not connect to programmer on port lpt1 or Parallel port device does not support IEEE-1284 
• Remove the dongle.

Could not connect to programmer on port lpt1 or Parallel 
port device does not support IEEE-1284 negotiation 
protocol

Possible Causes: These errors can occur because the remote device does not respond to the 
negotiation protocol, for a variety of reasons. 

Solutions:

• Make sure the port is connected

• Make sure the connected device is a FlashPro/Lite programmer

• Turn the programmer on

• Check parallel port setting in BIOS 

• Make sure that there are no dongles in between the parallel port and the FlashPro connection

• Try another parallel cable, the parallel cable might be defective

• Check to see if the programmer is damaged (see step 4 in “Software Freeze” on page 115)

• Make sure the FlashPro Lite has power. The FlashPro Lite is powered from the target board 
through the Vdd pin of the programming header. Please make sure the Vdd pin is connected and 
the target board is powered up.

External Voltage Detected on <Supply>
From the CONNECT menu, the FlashPro programmer has been told to power a supply (one of 
Vdd, Vddp, Vpp, Vpn) of the FPGA, but it is already driven from another source. The FlashPro has 
sense-amps on all the power supplies to make sure that it does not drive a power supply that is 
already driven by the board.

Possible Cause: The voltage supply for the FPGA is driven by the another source (board, external 
power-supply), but the user forgot to turn off the supply in the CONNECT menu.

Solution: Set appropriate options in the CONNECT menu.
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Failed self-test. VDDP setting: Expected 2300...27000. Actual 750
Failed self-test. VDDP setting: Expected 2300...27000. 
Actual 750

This failure happens due to low VDDP. A loose cable connector usually causes a low voltage or 
no voltage. 

Possible Cause: The cable may have become loose if the cable was disconnected from the target 
by pulling up on the cable instead of lifting the connector directly. 

Solution: Secure the connection between the cable connector and the programming header.

Loopback Failure TDI -> TDO. Expected 1, Actual 0
Possible Causes: An error message indicating a mismatch between expected signal values of 1 
or 0 indicates a hard failure. The signals will be TCK, OUT0, or TDI. 

Solution: Send the programmer back for repair.

More than one unidentified device cannot continue
In order to perform an operation to the ProASIC device, the rest of the devices in the chain 
must be in bypass mode. To put the devices into bypass mode, the programmer must need to 
know the IDCODE (hence the instruction register length) of these devices. If there is more 
than one device in the chain which does not support IDCODE command, then the 
programmer cannot put them into bypass mode, therefore cannot reach the desired ProASIC 
device.

Possible Causes:

• The user has chained the ProASIC device with non-Actel devices. Currently that is not 
supported in our software.

• One or more of the devices in the chain is damaged, and the IDCODE cannot be read back.

Solution:

Please remove all non-Actel devices from the chain. If you still experience the failure, it is likely 
that the device's ID CODE can not be read and you need to replace the device.
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Self-test
Self-test
Before you program any devices, you should run the self-diagnostic test (see “Self-Test” on page 
13). The diagnostic software can be found on the Actel web site. If the test fails, please contact Actel 
Customer Technical Support at tech@actel.com for credit and replacement.

Note: The Self-test is only available for FlashPro, not FlashPro Lite.

VDDP Disconnected
This message occurred because there is no Vddp voltage supply to the FPGA.

Possible Causes: 

• You accidentally turned off the Vddp supply in the CONNECT menu.

• The Vddp supply on the board is not functioning.

Solution: Please check the Vddp supply on the board for appropriate voltages and correct the 
CONEECT menu.

Table A-1 lists exit codes are for ProASIC3/E devices.

Table A-1. ProASIC3/E Device Exit Codes

Exit 
Code

Description Possible Cause(s) Solution(s)

0
This message means 
success. This does 
not indicate an error.

1

Exit 1 is defined as a 
checking chain error. 
This means that the 
physical chain does 
not match the 
expected setup from 
the STAPL file.

• The physical chain config-
uration has been altered.
• The specific IR length of 
non-Actel devices may be 
incorrect.
• The order of the specified 
chain may be incorrect. For 
example, the chain order 
may be in the reverse order.
• Something has become 
disconnected in the chain.

• Check the physical 
chain configuration 
against Chain-
Builder’s 
configuration.
• Check the 
programmer header 
connection.
• Check the 
connection between 
the FlashPro3 pro-
grammer and the PC.
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VDDP Disconnected
5, -25, 
-26

Entering ISP failure.
Indicates there is a problem 
in the programming 
environment setup.

• Check the connec-
tion of the program-
mer header.
• Check the connec-
tion between the 
FlashPro3 program-
mer and the 
PC 3. 
• Check that all the 
required voltages are 
provided for ISP 
programming.

6

The IDCODE of 
the target device 
does not match the 
expected value in the 
STAPL file.

• The STAPL file does not 
match the targeted device.
• You selected a wrong 
device.
• Device TRST pin is 
grounded.
• Noise or reflections on 
one or more of the JTAG 
pins caused by the IR Bits 
reading it back.

• Choose the correct 
STAPL file and select 
the correct device.
• Measure JTAG pins 
and noise or reflec-
tion. TRST should be 
floating or tied high.
• Cut down the extra 
length of ground con-
nection.

8
FPGA Array erase 
failure

• The device is secured, and 
the corresponding STAPL 
file with the correct security 
information is not loaded. 
The device has been perma-
nently secured and cannot 
be unlocked.

Make sure you loaded 
the correct STAPL 
file.

Table A-1. ProASIC3/E Device Exit Codes

Exit 
Code

Description Possible Cause(s) Solution(s)
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VDDP Disconnected
10
FPGA Array 
programming failure

• The device is secured, and 
the corresponding STAPL 
file with the correct security 
information is not loaded.
• The device has been 
permanently secured and 
cannot be unlocked.

Make sure you loaded 
the correct STAPL 
file.

11

FPGA Array Verifi-
cation Failure: 
Device content does 
not match with the 
STAPL file.

• Device content does not 
match the STAPL file.
• The device is secured, and 
the STAPL file does not 
contain the correct security 
information.
• The device was not 
programmed successfully.

• Make sure the cor-
rect STAPL file was 
loaded correctly. 
• Verify the correct 
STAPL file was 
loaded for the verifi-
cation process.
• Verify all the power 
supply voltages meet 
the datasheet specifi-
cation.

14

Security status 
register 
programming 
failure
Note: The device 
security setting may 
not be properly set 
due to this failure, 
and the device will 
be erased 
automatically.

• The device is secured, and 
the corresponding STAPL 
file with the correct security 
information is not loaded.
• Failed to program the 
security setting for the 
device.
• The device has been per-
manently secured and 
cannot be unlocked.

Make sure you loaded 
the correct STAPL 
file.

Table A-1. ProASIC3/E Device Exit Codes

Exit 
Code

Description Possible Cause(s) Solution(s)
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VDDP Disconnected
-18

Encrypted Data 
Authentication Fail-
ure: Failed to 
authenticate the 
encrypted STAPL 
file.

• Make sure the data is 
encrypted with the same 
AES Key as the one
programmed into the 
device.

Regenerate the 
STAPL file with the 
correct AES Key.

-19
FlashROM 
programming failure

•  The device is secured, and 
the corresponding STAPL 
file with the correct security 
information is not loaded. 
• The device has been per-
manently secured and 
cannot be unlocked.

Make sure you loaded 
the correct STAPL 
file.

-20
FlashROM 
verification failure

• The FlashROM content 
in the device does not 
match the STAPL file.
•  The device is secured, and 
the corresponding STAPL 
file with the correct security 
information is not loaded. 
• The device has been
permanently secured and 
cannot be unlocked.
• If you are using Serializa-
tion, you may have used the 
wrong serial index to verify 
the FlashROM content.
• The FlashROM was not 
programmed successfully.

• Make sure you 
loaded the correct 
STAPL file.
• If the you are using 
serialization, please 
make sure that you 
have selected the cor-
rect serial index.

Table A-1. ProASIC3/E Device Exit Codes

Exit 
Code

Description Possible Cause(s) Solution(s)
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VDDP Disconnected
-21
FlashROM erase 
failure

•  The device is secured, and 
the corresponding STAPL 
file with the correct security 
information is not loaded. 
• The device has been 
permanently secured and 
cannot be unlocked.

• Make sure you 
loaded the correct 
STAPL file.

-22
Pass Key 
programming failure

•  The device is secured, and 
the corresponding STAPL 
file with the correct security 
information is not loaded.
• The device has been 
permanently secured and 
cannot be unlocked.

• Make sure you 
loaded the correct 
STAPL file. 

-23, -31, 
-32

AES Key 
programming failure

•  The device is secured, and 
the corresponding STAPL 
file with the correct security 
information is not loaded. 
• The device has been 
permanently secured and 
cannot be unlocked.

• Make sure you 
loaded the correct 
STAPL file. 

-24
Information 
Programming 
Failure

Connection to the device 
may be interrupted.

• Check the program-
mer header connec-
tion .
• Check the connec-
tion between the 
FlashPro3 program-
mer and the PC.
• Verify that all the 
required voltages are 
provided for ISP pro-
gramming.

Table A-1. ProASIC3/E Device Exit Codes

Exit 
Code

Description Possible Cause(s) Solution(s)
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B
Electrical Pin Outs 

Programmer electrical parameter information for FlashPro3, FlashPro Lite, and FlashPro are 
located in Table 0-4 thorugh Table 0-8. Electrical pin out diagrams of FlashPro3, FlashPro 
Lite, and FlashPro are shown below. 

Note: You should take the following precautions if you want to wire your own header 
arrangements:

• All the ground pins must be individually connected to ground to ensure reliable 
programming and to ensure that they are not connected internally in the programmer.

• Keep cable lengths short to avoid signal integrity problems.

FlashPro3
The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. 
The connector on the FlashPro3 unit is a 2x5, RA male Header connector, which is 
manufactured by AMP and has a manufacturer’s part number of 103310-1. This is a standard 
2x5, 0.1 pitch connector which is keyed. 

The signals on the pins of the FlashPro3 10-pin connector are shown in Figure B-1 below 
(extracted from FlashPro3 product specification):

Figure B-1. 10-Pin Connector
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FlashPro Lite
Table B-1 shows a description of the signals..

FlashPro Lite
For FlashPro Lite, the existing 26-pin connector is shown in Figure B-2. See Table B-2 for a 
description of the signals.

Figure B-2. 26-Pin Connector

Table B-1. FlashPro3 Signal Description

Signal Description

VPUMP 3.3V Programming voltage

GND Signal reference

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device

TMS JTAG mode select

nTRST
Programmable output pin may be set to off, toggle, 
low, or high level

VJTAG Reference voltage from the target board

N/C Programmer does not connect to this pin
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FlashPro Lite
The appropriate SAMTEC micro connnector target cable for this is: 
Samtec FFSD-13-D-12.00-01-N.

The 12 inch cable is specified. This is likely to be more than enough to connect to the board 
and reducing the inductance will help compared with 18 inches, which is supplied by the 
default with FlashPro Lite. 

Note: All ground pins must be connected. 

Table B-2. FlashPro Lite Signal Description

Signal Description

VDDP VDD supply for logic I/O pads

VDDL VDD supply for core

VPP Positive programming supply (+16.5V)

VPN Negative programming supply(-13.8V)

GND Signal reference

SENSE
Input from target board to programmer to indicate 
connection to ground

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device

TMS JTAG mode select

nTRST
Programmable output pin may be set to off, toggle, 
low, or high level

RCK/OUT0
Programmable output pin may be set to off, toggle, 
low, or high level

N/C Programmer does not connect to this pin
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FlashPro
FlashPro
For FlashPro, you can use the same 26-pin target cable you used for FlashPro Lite, but the 
connections are shown in Figure B-3.

Figure B-3. FlashPro 26-Pin Connector

Table B-3 shows the signal pin descriptions for FlashPro.

Table B-3. FlashPro Signal Description

Signal Description

VDDP VDD supply for logic I/O pads

VDDL VDD supply for core

VPP Positive programming supply (+16.5V)

VPN Negative programming supply(-13.8V)

GND Signal reference

SENSE
Input from target board to programmer to indicate 
connection to ground

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device
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Programmer Electrical Parameters
Table B-4 shows DC characteristics for FlashPro3.

TMS JTAG mode select

nTRST
Programmable output pin may be set to off, toggle, 
low, or high level

RCK/OUT0
Programmable output pin may be set to off, toggle, 
low, or high level

2.5V, 2.5V/3.3V, N/C Programmer does not connect to these pins

Table B-3. FlashPro Signal Description

Signal Description

Table B-4. DC Characteristic for FlashPro3

Description Symbol Min Max Unit

 Input low voltage, TDO VIL -0.5
0.35*VJT
AG

V

Input high voltage, TDO VIH 0.65*VJTAG 3.6 V

Input current, TDO IIL, IIH -20 +20 µA

Input capacitance, TDO 40 pF

Output voltage, VPUMP, 
operating

VPP +3.0 +3.6 V

Output current, VPUMP IPP 250 mA

VJTAG = 1.5V

Output low voltage, TCK, 
TMS, TDI, 100µA load

VOL 0.0 0.2 V

Output low voltage, TCK, 
TMS, TDI, 4mA load

VOL 0.0
0.30*VJT
AG

V
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Programmer Electrical Parameters
Output high voltage, TCK, 
TMS, TDI, 100µA load

VOH VJTAG-0.2 VJTAG V

Output high voltage, TCK, 
TMS, TDI, 4mA load

VOH 0.70*VJTAG VJTAG V

Output current, TCK, TMS, 
TDI

IOL, IOH -4 +4 mA

VJTAG = 2.5V

Output low voltage, TCK, 
TMS, TDI, 100µA load

VOL 0.0 0.2 V

Output low voltage, TCK, 
TMS, TDI, 8mA load

VOL 0.0 0.6 V

Output high voltage, TCK, 
TMS, TDI, 100µA load

VOH VJTAG-0.2 VJTAG V

Output high voltage, TCK, 
TMS, TDI, 8mA load

VOH 1.8 VJTAG V

Output current, TCK, TMS, 
TDI

IOL, IOH -8 +8 mA

VJTAG = 3.3V

Output low voltage, TCK, 
TMS, TDI, 100µA load

VOL 0.0 0.2 V

Output low voltage, TCK, 
TMS, TDI, 8mA load

VOL 0.0 0.6 V

Output high voltage, TCK, 
TMS, TDI, 100µA load

VOH VJTAG-0.2 VJTAG V

Table B-4. DC Characteristic for FlashPro3

Description Symbol Min Max Unit
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Programmer Electrical Parameters
Table B-5 shows the DC characteristics for FlashPro Lite.

Output high voltage, TCK, 
TMS, TDI, 8mA load

VOH 2.4 VJTAG V

Output current, TCK, TMS, 
TDI

IOL, IOH -8 +8 mA

Table B-5. DC Characteristics for FlashPro Lite

Description Symbol Min Max Unit

Input low voltage, 
TDO

VIL -0.5 0.7 V

Input high voltage, 
TDO

VIH 1.7 5.0 V

Input current, TDO IIL, IIH -10 +10 µA

Input capacitance, 
TDO

40 pF

Input voltage, VDD, 
operating

+2.3 +3.5 V

Input voltage, VDD, 
power off

-1.0 +1.0 V

Input current, VDD IVDD 700 mA

Output voltage, VPP, 
operating

VPP +15.9 +16.5 V

Output voltage, VPN, 
operating

VPN -13.8 -13.4 V

Output current, IPP IPP 0 35 mA

Output current, IPN IPN 0 -15 mA

Table B-4. DC Characteristic for FlashPro3

Description Symbol Min Max Unit
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Programmer Electrical Parameters
Table B-6 shows DC characteristics for FlashPro.

Output low voltage, 
TCK, TMS, TDI, 
100uA load

VOL 0.0 0.2 V

Output low voltage, 
TCK, TMS, TDI, 
1mA load

VOL 0.0 0.5 V

Output low voltage, 
TCK, TMS, TDI, 
2mA load

VOL 0.0 0.8 V

Output high voltage, 
TCK, TMS, TDI, 
100uA load

VOH 2.1 2.5 V

Output high voltage, 
TCK, TMS, TDI, 
1mA load

VOH 1.9 2.5 V

Output high voltage, 
TCK, TMS, TDI, 
2mA load

VOH 1.6 2.5 V

Output current, TCK, 
TMS, TDI, nTRST

IOL, IOH -2 +2 mA

Table B-6. DC Characteristic for FlashPro

Description Symbol Min Max Unit

Input low voltage, TDO VIL -0.5
0.30 * 
VDDP

V

Input high voltage, TDO VIH
0.70 * 
VDDP

5.5 V

Table B-5. DC Characteristics for FlashPro Lite

Description Symbol Min Max Unit
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Programmer Electrical Parameters
Input current, TDO IIL, IIH -10 +10 µA

Input voltage, VDDP, VDDL 0 5.25 V

Input voltage, VPP 0 21.0 V

Input voltage, VPN -21.0 0 V

Input current, VDDP, VDDL, 
VPN, VPP

IVCC 5.0 mA

Output voltage range, VDDP VDDP 1.5 3.3 V

Output voltage range, VDDL VDDL 1.5 3.3 V

Output voltage range, VPP VPP 15.0 18.0 V

Output voltage range, VPN VPN -16.0 -12.0 V

Output voltage resolution / 
accuracy

100 / ±50 mV

Output current, IDDP IDDP -135 (1) +135 mA

Output current, IDDL IDDL -135 (1) +135 mA

Output current, IPP IPP -270 (1) +270 mA

Output current, IPN IPN -270 +270 (1) mA

Output low voltage, TCK, TMS, 
TDI, OUT0, nTRST

VOL 0.0 0.4 V

Output high voltage, TCK, 
TMS, TDI, OUT0, nTRST

VOH
0.85 * 
VDDP

VDDP + 
0.3

V

Output current, TCK, TMS, 
TDI, OUT0, nTRST

IOL, IOH -12 +12 mA

Table B-6. DC Characteristic for FlashPro

Description Symbol Min Max Unit
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Programmer Electrical Parameters
Note (1): When power supply mode is set to ABI_GROUND.

Table B-7 shows the JTAG switching characteristics for FlashPro3.

Table B-8 shows the JTAG switching characteristics for FlashPro and FlashPro Lite measured at the 
programmer end of the JTAG cable.

Table B-7. JTAG Switching Characteristics for FlashPro3

Description Symbol Min Max Unit

Output delay from TCK to TDI, 
TMS

TTCKTDI -2 2 ns

TDO setup time before TCK ris-
ing, VJTAG=3.3

TTDOTCK 12 ns

TDO setup time before TCK ris-
ing, VJTAG=1.5

TTDOTCK 14.5 ns

TDO hold time after TCK rising TTCKTDO 0 ns

TCK period TTCK 41.7 10667 ns

Table B-8. JTAG Switching Characteristics for FlashPro and FlashPro Lite

Description Symbol Min Max Unit

Output delay from 
TCK falling to TDI, 
TMS

TTCKTDI -2.0 2.0 ns

TDO Setup time 
before TCK rising

TTDOTCK 5.0 ns

TDO Hold time after 
TCK rising

TTCKTDO 0 ns

TCK period TTCK 40 10240 ns
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Figure B-4 shows an illustration of the JTAG switching characteristics in Tables B-4 and B-5.

Figure B-4. JTAG Switching Characteristics Illustration
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C
Software Freeze

The software may freeze if there are any unexpected events that terminate the communication 
between the programmer and the PC. For example, the software may freeze if you short the  
connection pins of the programmer to ground. This causes an excessive amount of current 
(drawing from the programmer), which may potentially damage the programmer and/or the 
device.

To restart the software after a crash:

1. Power-down everything.

• If Vpp and Vpn are provided on the board, power them down first, then power down Vdd 
and Vddp. Finally, power down the FlashPro and disconnect it from the board.

• If the FlashPro is providing all the voltages, power down the FlashPro and disconnect it from 
the board.

2. Close the FlashPro software.

3. On the FPGA, measure resistance between all power supplies to GND. If any power 
supply is shorted to GND, then the device is damaged. Don't power up the board.

4. Power up the FlashPro, invoke the FlashPro software, and run self-test (“Self-Test” on 
page 13).

5. Assuming that the FPGA does not have any supply to GND short, reconnect the 
FlashPro and run an Analyze Chain (“Analyze Chain and Device Selection” on page 
23).
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D
Product Support

Actel backs its products with various support services including Customer Service, a Customer 
Applications Center, a web site, an FTP site, electronic mail, and worldwide sales offices. This 
appendix contains information about contacting Actel and using these support services. 

Actel U.S. Toll-Free Line
Use the Actel toll-free line to contact Actel for sales information, technical support, requests 
for literature about Actel and Actel products, Customer Service, investor information, and 
using the Action Facts service.

The Actel toll-free line is (888) 99-ACTEL.

Customer Service
Contact Customer Service for nontechnical product support, such as product pricing, product 
upgrades, update information, order status, and authorization.

From Northeast and North Central U.S.A., call (650) 318-4480.
From Southeast and Southwest U.S.A., call (650) 318-4480.
From South Central U.S.A., call (650) 318-4434.
From Northwest U.S.A., call (650) 318-4434.
From Canada, call (650) 318-4480.
From Europe, call (650) 318-4252 or +44 (0) 1276 401500.
From Japan, call (650) 318-4743.
From the rest of the world, call (650) 318-4743.
Fax, from anywhere in the world (650) 318-8044.

Customer Applications Center
Actel staffs its Customer Applications Center with highly skilled engineers who can help 
answer your hardware, software, and design questions. The Applications Center spends a great 
deal of time creating application notes and answers to FAQs. So, before you contact us, please 
visit our online resources. It is very likely we have already answered your question(s).

Guru Automated Technical Support
Guru is a web-based automated technical support system accessible through the Actel home 
page (http://www.actel.com/custsup/search.html). Guru provides answers to technical 
questions about Actel products. Many answers include diagrams, illustrations, and links to 
other resources on the Actel web site. Guru is available 24 hours a day, seven days a week.
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Web Site
Web Site
Actel has a World Wide Web home page where you can browse a variety of technical and 
nontechnical information. Use a Net browser (Netscape recommended) to access Actel’s home page.

The URL is http://www.actel.com. You are welcome to share the resources provided on the 
Internet. 

Be sure to visit the Technical Documentation area on our web site, which contains information 
regarding products, technical services, current manuals, and release notes.

FTP Site
Actel has an anonymous FTP site located at ftp://ftp.actel.com. Here you can obtain library 
updates, software patches, design files, and data sheets.

Contacting the Customer Applications Center
Highly skilled engineers staff the Customer Applications Center from 7:30 A.M. to 5:00 P.M., 
Pacific Time, Monday through Friday. Several ways of contacting the Center follow:

Email

You can communicate your technical questions to our e-mail address and receive answers back by e-
mail, fax, or phone. Also, if you have design problems, you can e-mail your design files to receive 
assistance. We constantly monitor the e-mail account throughout the day. When sending your 
request to us, please be sure to include your full name, company name, and your contact information 
for efficient processing of your request.

The technical support e-mail address is tech@actel.com.

Telephone

Our Technical Message Center answers all calls. The center retrieves information, such as your 
name, company name, phone number and your question, and then issues a case number. The Center 
then forwards the information to a queue where the first available application engineer receives the 
data and returns your call. The phone hours are from 7:30 A.M. to 5:00 A.M., Pacific Time, Monday 
through Friday.

The Customer Applications Center number is (800) 262-1060.

European customers can call +44 (0) 1256 305600.
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Headquarters Worldwide Sales Offices
Worldwide Sales Offices

Headquarters
Actel Corporation
2051 Stierlin Court
Mountain View, California 
94086
Toll Free: 888.99.ACTEL
Tel: 650.318.4200
Fax: 650.318.4600

US Sales 
Offices

California

Bay Area
Tel: 650.318.4200
Fax: 650.318.4600

Irvine
Tel: 949.788.0980
Fax: 949.788.0822

Newbury Park
Tel: 805.375.5769
Fax: 805.375.5749

Colorado

Tel: 303.420.4335
Fax: 303.420.4336

Florida

Tel: 407.977.6846
Fax: 407.977.6847

Georgia

Tel: 770.623.3960
Fax: 770.831.0055

Illinois

Tel: 847.259.1501
Fax: 847.259.1572

Massachusetts

Tel: 978.244.3800
Fax: 978.244.3820

Minnesota

Tel: 651.917.9116
Fax: 651.917.9114

North Carolina

Tel: 919.654.4529
Fax: 919.674.0055

Pennsylvania

Tel: 215.794.2050
Fax: 215.706.0680

Texas

Tel: 972.312.8700
Fax: 972.312.8707

International Sales 
Offices

Canada
Suite 106
235 Stafford Rd. West,
Nepean, Ontario K2H 9C1
Tel: 613.726.7575
Fax: 613.726.8666

France
361 Avenue General de Gaulle
92147 Clamart Cedex
Tel: +33 (0)1.40.83.11.00
Fax: +33 (0)1.40.94.11.04

Germany
Actel GmbH
Lohweg 27, 
D-85375 Neufahrn, Germany
Phone: +49.(0)81.659.584.0
Fax: +49.(0)81.659.584.10
Hong Kong
39th Floor, 
One Pacific Place, 
88 Queensway 
Admiralty,  Hong Kong 
Tel: +011.852.227.35712
Fax: +011.852.227.35999

Italy
Via Giovanni da Udine No. 34
20156 Milano
Tel: +39 (0)2.3809.3259
Fax: +39 (0)2.3809.3260

Japan
EXOS Ebisu Building 4F
1-24-14 Ebisu Shibuya-ku
Tokyo 150
Tel: +81 (0)3.3445.7671
Fax: +81 (0)3.3445.7668

Korea
30th Floor, ASEM Tower,
159-1 Samsung-dong
Kangnam-ku, Seoul
Tel: +82 (0)2.6001.3382
Fax: +82 (0)2.6001.3030

Nordic
Sveavagen 49
Djursholm 18262
Sweden

Tel: +46.8544.99025 
Fax: +46.8544.99026

Taiwan
4F-3, No. 75, Sec. 1,
Hsin-Tai-Wu Road,
Hsi-chih, Taipei, 221 
Tel: +886.928.273190
Fax: +886.226.626251

United Kingdom
Dunlop House,
Riverside Way
Camberley,
Surrey GU15 3YL
Tel: +44 (0)1276.401450
Fax: +44 (0)1276.401490
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